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1 Setting Up the AirPort Base Station
With the Apple AirPort Base Station, you can do the following:

m Set up an AirPort network in your home or school.

m Provide wireless Internet access to AirPort-equipped computers.

m Provide access to your existing Ethernet network to AirPort-equipped computers.

m Simultaneously share a single Internet connection between multiple computers.

Getting Started

Before you set up your AirPort Base Station, make sure of the following:

m you have an AirPort-equipped computer with an AirPort Card installed

m the computer is already configured to access the Internet using its built-in modem or 
another method such as a cable modem, DSL modem, or Ethernet network. (As part of the 
setup process, a copy of your computer’s Internet settings will be transferred to the AirPort 
Base Station.)

Note: To use the AirPort Base Station internal modem for Internet access, you must have 
an account with an Internet service provider (ISP) that uses standard Internet protocols. 
The AirPort Base Station cannot be used for Internet access with ISPs that use non-standard 
methods to connect to the Internet, such as America Online version 4.0. In addition, ISP 
accounts that use connection scripts or terminal login windows are not supported. For 
more information, contact your ISP.

Did You Purchase the Base Station With Your New Computer?

If you purchased the AirPort Base Station and your computer at the same time, you can use the 
Setup Assistant (which runs the first time you start up your computer) to set up an Internet 
account. Use the Setup Assistant to get an Internet account using your computer’s built-in 
modem or other method. This Internet account will be transferred to the AirPort Base Station 
when you set up the base station using the AirPort Setup Assistant described in this manual.
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About AirPort

AirPort technology offers an easy and affordable way to provide wireless Internet access 
anywhere in your home or classroom. Instead of using traditional cables to create a network, 
AirPort uses wireless local area network (LAN) technology to provide communication between 
computers.

How AirPort Works

In a traditional network, computers are connected through a series of wires that transfer 
information among them. With AirPort, data is transferred between computers using radio 
waves, creating a wireless network.

There are two ways to create a wireless network. You can use a device known as a “base 
station.” In this kind of network, all wireless communication goes through the base station to 
other computers on the network or to the Internet. In addition, when two or more AirPort-
equipped computers are in range of each other, they can use AirPort to communicate directly. 
This connection is known as a “computer-to-computer” AirPort connection.

How the Apple AirPort Base Station Works

The AirPort Base Station uses a wireless radio card to create an AirPort network that other 
computers can use to access the Internet. There are two ways that you can use the AirPort 
Base Station to provide Internet access:

m Connect the AirPort Base Station to an existing Ethernet network that already has Internet 
access.

m Connect a telephone line, cable modem, or DSL modem to the AirPort Base Station. 

When any computer on the AirPort network uses an application that requires a connection to 
the Internet, such as a Web browser or e-mail program, the AirPort Base Station establishes the 
connection to the Internet and provides it to all of the computers on the network. 

Note: To use AirPort to access the Internet, you must have an account with an Internet service 
provider (ISP). In addition, you need a traditional way to access the Internet, through a phone 
line, cable modem, DSL modem, or Ethernet network.
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Setting Up Your AirPort Base Station

Follow the steps in this section to set up your AirPort Base Station.

Step 1: Decide Where to Place Your AirPort Base Station

You can place your AirPort Base Station on a desk, bookcase, or other flat surface, or you can 
mount it on a wall. For optimal performance, place your AirPort Base Station in the center of 
your home in a location that is away from any potential source of interference, such as a metal 
wall or microwave oven. This location must be close to power and phone outlets (or a network 
connection).

For more information on sources of interference and deciding where to place an AirPort Base 
Station, choose Mac Help from the Help menu, then search for “base station placement” or 
“AirPort interference” after you install the AirPort software.

An ideal location for the AirPort Base Station is on a desk or bookcase near power and phone 
outlets (or a network connection). Your AirPort Base Station can also be mounted on a wall 
using the bracket and screws provided with the base station. For instructions on mounting the 
base station, see “Mounting the AirPort Base Station on a Wall” on page 13.
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Step 2: Plug In the Base Station

1 Plug the AirPort Base Station power adapter into the power adapter port and connect it to an 
electrical outlet.

The AirPort Base Station automatically turns on when the power adapter is plugged in and 
connected to an electrical outlet. There is no power switch. 

When you first plug in the base station, the status lights will glow amber and red. These lights 
indicate that the base station is starting up. When the middle light glows green, startup is 
complete. The startup process takes about 30 seconds.

2 Connect the AirPort Base Station to your phone line or network.

m If you use a standard modem and analog telephone line (the type of telephone line found 
in most residences) to access the Internet, connect one end of the phone cable to the 
internal modem port and the other end to your telephone jack.

m If you have an Internet account that uses a device such as a cable or DSL modem, connect 
the device to the Ethernet port on the AirPort Base Station (the same way it was connected 
to your computer).

Important  Use only the power adapter that came with your AirPort Base Station. Adapters for 
other electronic devices may look similar, but they may damage the base station.

Internal
modem port

Power
adapter port

Ethernet
port

GW
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Step 3: Install the AirPort Software

Even though AirPort software may already be installed on your computer, you should install 
the AirPort software that came with the base station to make sure that you have the latest 
version of the software.

1 Insert the AirPort software CD.

2 If necessary, select the folder that contains the software for your language.

3 Double-click the Apple SW Install icon and follow the onscreen instructions.

Step 4: Set Up Your AirPort Network

You use the AirPort Setup Assistant to configure the AirPort Base Station to create a wireless 
network with Internet access. The assistant guides you through the process of setting up your 
AirPort network, transferring your existing Internet settings from your computer to the AirPort 
Base Station, and creating new network settings for your computer so that it can access the 
network created by the AirPort Base Station.

After the computer restarts, the AirPort Setup Assistant automatically opens. If the AirPort 
Setup Assistant does not open automatically or you need to use it later, you can find it in the 
Assistants folder on your hard disk.

Note: The AirPort Setup Assistant creates new TCP/IP and AppleTalk configurations that use 
AirPort as their connect via method. In addition the TCP/IP configuration is set to configure 
using a DHCP server so that it can obtain its IP address from the AirPort Base Station.

The AirPort Setup Assistant screen that 
appears if a new AirPort Base Station 
is detected and the computer has 
never been set up to use AirPort. 

A different screen will appear if there 
are other networks in range or the 
computer has already been set up to 
use AirPort.
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Step 5: Access the AirPort Network and Connect to the Internet

After you’ve finished using the AirPort Setup Assistant, your computer is automatically set to 
access the AirPort network created by the base station and is ready to access the Internet. 

To use your AirPort Base Station to access the Internet, do the following:

1 Choose AirPort from the Apple (K) menu.

2 Make sure that your AirPort network is selected. 

If it is not selected, click the Show Settings button and then choose your network from the 
Choose Network pop-up menu.

Note: Your computer remembers the last AirPort network you were connected to and tries to 
reconnect to the network every time you start up your computer or wake it from sleep. If you 
did not switch networks, you will not have to select the AirPort network again when you start 
up or wake your computer. 

3 If you use the internal modem in the AirPort Base Station to connect to the Internet, click the 
Connect button. If you use another method, skip to step 5.

The AirPort Base Station dials and connects to your ISP.

4 Wait until the AirPort application indicates that a connection is established.

5 Open your Web Browser, e-mail, or other Internet application.

Note: The speed at which you can access information on your network depends on where 
you are accessing the information from. The transfer rate between the base station and 
computers on the network is up to 11 megabits per second (Mbps). However, information 
from the Internet can only be transferred as fast as the AirPort Base Station modem (or other 
external modem) can communicate.

What’s Next

Your AirPort Base Station is now set up and connected to the Internet. In the next several 
pages you will find additional information on the following:

m Monitoring AirPort Base Station status

m Connecting additional computers to your AirPort network

m Disconnecting from the Internet

m Switching network settings and automatically connecting to the Internet

m Manually configuring your AirPort Base Station

m Using the AirPort Base Station with non-AirPort-equipped computers

m Mounting the AirPort Base Station on a wall

m Troubleshooting
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Monitoring AirPort Base Station Status

You can use the AirPort application to monitor the status of your AirPort Base Station. The 
lights on the AirPort Base Station also show its status. The base station has three lights that 
indicate the following:

m Light 1:  AirPort communication

m Light 2:  Power

m Light 3:  Ethernet or modem communication

.

Note: The AirPort Base Station does not have an internal speaker, so you do not hear the 
modem dial when the base station is connecting to the Internet.

1     2     3

Light number Indicator Status

1 Flashing green AirPort communication in progress

2 Steady green The AirPort Base Station is receiving power and 
in normal operating mode

3 Flashing green Ethernet or modem communication in 
progress

3 Flashing amber Temporarily appears when the Internal modem 
is dialing your ISP
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Connecting Additional Computers to Your AirPort Network

Once you’ve set up the AirPort Base Station, you can configure any AirPort-equipped computer 
to access the wireless network you just created by opening the AirPort Setup Assistant on the 
computer you want to access the network and choosing the “Set up your computer to join an 
existing wireless network” option. 

For information on configuring non-AirPort-equipped computers to use the AirPort Base 
Station, see “Connecting to the Internet Automatically” on page 11.

Disconnecting From the Internet

The AirPort Base Station automatically disconnects from the Internet after a period of 
inactivity, based on the time set in the Internet settings that were used to configure the base 
station. If no time was specified, the base station disconnects after 10 minutes of inactivity. You 
can adjust this time using the AirPort Admin Utility program, located in the AirPort folder 
inside the Apple Extras folder. You can also manually disconnect from the Internet, using the 
AirPort application.

Switching Network Settings

The AirPort Setup Assistant creates new network configurations for AirPort and makes those 
configurations active. You can switch to your older settings so that you can use the modem in 
your computer to connect to the Internet instead of using AirPort. To switch settings, do the 
following.

1 Choose Control Panels from the Apple (K) menu, then choose TCP/IP from the submenu.

2 Choose Configurations from the File menu.

3 Select the TCP/IP configuration you would like to use and click Make Active.

4 Close the TCP/IP control panel.

5 Choose Control Panels from the Apple (K) menu, then choose AppleTalk from the submenu.

6 Choose Configurations from the File menu.

7 Select the AppleTalk configuration you would like to use and click Make Active.

8 Close the AppleTalk control panel.

Your computer is now ready to access the Internet using the method you selected.
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Connecting to the Internet Automatically 

If you are already connected to an AirPort network that has Internet access, you can connect to 
the Internet by opening and using any application that requires an Internet connection, such 
as your e-mail program or Web browser instead of using the AirPort application. The AirPort 
Base Station automatically establishes an Internet connection when it is needed by any of the 
computers on the network.

Manually Configuring Your AirPort Base Station

You can use the AirPort Admin Utility (located in the AirPort folder inside the Apple Extras 
folder on your hard disk) to configure your AirPort Base Station. The AirPort Admin Utility 
allows you to do the following:

m Configure your AirPort network including changing the network name, password, and 
whether or not your AirPort network is encrypted.

m Change the AirPort Base Station name and password.

m Enter the TCP/IP settings for your AirPort Base Station.

m Configure ISP information such as telephone number, user name, and password.

m Set up how Internet access is provided to computers on the AirPort network.

Note: By default, the AirPort Base Station is set to use DHCP to share a single IP address 
obtained from your ISP with any computer that is connected to it. The IP address provided 
by the base station is a private address in the range of 10.0.1.2 to 10.0.1.50. Instead of using 
the default setup, you can use the AirPort Admin Utility to configure the base station to 
distribute a specified range of IP addresses or turn off Internet sharing and assign fixed IP 
addresses to all computers on the network instead..

For more information on configuring an AirPort Base Station choose Mac Help from the Help 
menu and then search for “AirPort Base Station.” For information on the different options in 
the AirPort Admin Utility, choose Show Balloons from the Help menu. Then point to the item 
you are interested in.

Important  The time it takes the AirPort Base Station modem to make the connection 
depends on the condition of your telephone line and which ISP you are connecting to. If you 
see an error message indicating that a connection error occurred, wait until the AirPort 
application indicates that the base station is connected or the right LED light on the AirPort 
Base Station has stopped blinking amber. Then use your Web browser to go to a page.

Important  If you use the AirPort Admin Utility to configure your base station for the first 
time instead of using the Setup Assistant you may be prompted for a password. The initial 
password for the AirPort Base Station is public.
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Using the Base Station With Non-AirPort-Equipped Computers

Because the AirPort Base Station has an Ethernet port, you can connect it to any Macintosh 
computer with an Ethernet port or attach it to an existing network of Macintosh computers. 
Computers connected using Ethernet can share the single Internet connection provided 
through the AirPort Base Station internal modem. You do not need to install the AirPort 
software on a computer connected to the AirPort Base Station via Ethernet.

To configure a non-AirPort-equipped computer to be part of the AirPort network, do this:

1 Connect a cable from the Ethernet port on the computer to the Ethernet port on the AirPort 
Base Station. 

If you have only one computer, connect it to the base station using an Ethernet crossover 
cable. If you have multiple computers, you can connect the computers to an Ethernet hub and 
connect the hub to the AirPort Base Station. Ethernet hubs and crossover cables are available 
from your Apple-authorized dealer.

2 Choose Control Panels from the Apple (K) menu, then choose TCP/IP from the submenu.

3 Choose “Ethernet built-in” from the Connect via pop-up menu and then choose “Using a 
DHCP Server” from the Configure pop-up menu. Then close the TCP/IP control panel.

4 Open your Web browser, e-mail, or other Internet application to cause the AirPort Base Station 
to automatically connect to the Internet.

Note: By default, this option is turned off in the AirPort Admin Utility if the AirPort Base 
Station is connected to the Internet using Ethernet.

Important  To configure the AirPort Base Station using the AirPort Setup Assistant, you must 
have an AirPort-equipped computer. Once it is configured you can connect additional 
computers to it using Ethernet.
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Mounting the AirPort Base Station on a Wall

You can use the mounting bracket provided with your AirPort Base Station to mount it on a 
wall.

To mount the AirPort Base Station on a wall, follow these steps:

1 Select a location close to power and phone outlets (or a network connection).

2 Screw the mounting bracket into a wall stud using the two screws that came with the base 
station.

3 Locate the three mounting bracket holes on the bottom of the base station.

Mounting bracket

Mounting bracket holes
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4 Feed the cables through the mounting bracket and then connect them to the base station. The 
unit is designed to mount with the ports on the top (Apple logo right-side up), with the cables 
passing behind the unit through the mounting bracket as shown.

Note: The mounting bracket has enough space so that three cables (power, phone, and 
Ethernet) can be routed through it as shown in the illustration above, even though in most 
cases only two cables are used.

5 Carefully attach the AirPort Base Station to the mounting bracket.
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Additional Information

For more information on using or configuring the AirPort Base Station, see the “Wireless 
Internet and Networking” section of Mac Help, available in the Help menu. There you will find 
information on editing base station settings, avoiding sources of wireless interference, locating 
additional information on the Internet, and more.

You can also find more information on the following Apple Web sites:

m Apple’s AirPort Web site at www.apple.com/airport

m Apple’s Support Web site at www.apple.com/support

Troubleshooting

The AirPort Setup Assistant says that the proper AirPort hardware was not 
detected.

m Make sure that the computer you are using has an AirPort Card installed. If you recently 
installed the card, shut down your computer and check to make sure the card is properly 
installed. Make sure that the AirPort antenna is securely connected to the card and that the 
other end of the card is firmly inserted into the connector in the AirPort Card slot.

The “Set up an AirPort Base Station” option is not available, or the Setup 
Assistant is unable to detect the AirPort network created by the base station.

m Make sure that the AirPort Base Station is plugged into a working electrical outlet.

m Make sure that your computer is in range of the AirPort Base Station (the typical range for 
AirPort communication is up to 150 feet, or 45 meters).

m Make sure that your computer and AirPort Base Station are away from any source of 
potential interference, such as metal walls or microwave ovens. Reposition your computer 
and check to see if the network becomes available. If that does not work, try repositioning 
the base station. For a complete list of sources of interference, open the Help menu and 
choose Mac Help, then search for “AirPort interference.”

m Restart your computer.
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You have problems with your Internet connection.

m Test your Internet connection by connecting to the Internet using your computer’s internal 
modem or other method instead of using the AirPort Base Station.

After you test your Internet connection, make sure to switch your TCP/IP configurations 
back to AirPort by opening the TCP/IP control panel, choosing Configurations from the File 
menu, and selecting AirPort.

m To use the AirPort Base Station for Internet access, you must have an account with an 
Internet service provider (ISP) that uses standard Internet protocols. The AirPort Base 
Station cannot be used for Internet access with ISPs that use non-standard methods to 
connect to the Internet, such as America Online version 4.0. In addition, ISP accounts that 
use connection scripts or terminal login windows are not supported.

For more information on using the AirPort Base Station with your Internet account, contact 
your ISP or look on the Apple Support Web site at www.apple.com/support

Your Internet Browser is unable to load the requested Web page.

m You tried to go to a Web page before the AirPort Base Station was finished dialing and 
connecting to your ISP. Wait until the AirPort application indicates that you are connected 
and then go to the Web page again.

You forget your base station or network password.

You can use the reset button on the bottom of the AirPort Base Station to return the base 
station password and IP address to their default settings, then reconfigure the base station. 
Follow these steps:

1 Insert the end of a straightened paper clip into the small hole on the bottom of the base 
station.

Reset button
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2 Press and hold the reset button for one second. 

The base station and network passwords are set to public for five minutes.

3 If necessary, use the AirPort application to select the network created by the base station.

If you are prompted for a password, enter public.

4 Open the AirPort Admin Utility (in the AirPort folder in the Apple Extras folder).

5 Select your base station and click Configure.

You will be prompted to enter new network and base station passwords and in certain cases 
enter a new IP address.

Note: If you do not reconfigure the base station within five minutes, you must reset it again.

You move your AirPort Base Station to a location on your network with a 
different subnet.

Because your AirPort Base Station may have an invalid IP address, do the following. 

1 Make sure that your computer is set to access the network from the same location on the 
network where you are going to move the AirPort Base Station and that it is in range of the 
base station.

2 Make sure that the computer is currently set to use AirPort.

3 Use the AirPort Setup Assistant to reconfigure the base station.

Important  You cannot use the Setup Assistant if you have used the AirPort Admin Utility to 
turn off Internet sharing for your base station. If Internet sharing is turned off, you will need to 
reset your base station as described in the previous troubleshooting item and enter a new IP 
address when prompted.
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AirPort Base Station Specifications

AirPort specifications

m Wireless Data Rate:  Up to 11 megabits per second (Mbps)

m Range:  Up to 150 feet (45 meters) in typical use (varies with building)

m Frequency Band:  2.4 gigahertz (GHz)

m Radio Output Power:  15 dbm (nominal)

m Standards:  Compliant with 802.11 HR Direct Sequence Spread Spectrum (DSSS) 11 Mbps 
standard and 802.11 DSSS 1 and 2 Mbps standard

Interfaces

m RJ-11 connector for built-in 56K modem (supports V.90)

Note: Download speeds vary with line conditions and your ISP’s modem capabilities. FCC 
regulations limit ISP transmission speeds to 53 Kbps in the United States. 

m RJ-45 Ethernet connector for built-in 10BASE-T 

m AirPort

Environmental specifications

m Operating Temperature:  32° to 95° F (0° C to 35° C)

m Storage Temperature:  –13° to 140° F (–25° C to 60° C)

m Relative Humidity (Operational):  20% to 80% relative humidity

m Relative Humidity (Storage):  10% to 90% relative humidity, noncondensing

m Operating Altitude:  0 to 10,000 feet (0 to 3048 m)

m Maximum Storage Altitude:  15,000 feet (4572 m)

Size and weight

m Diameter: 6.9 inches (175 mm)

m Height:  3.2 inches (80 mm)

m Weight:  1.25 pounds (565 grams) not including the mounting bracket
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Communications Regulation Information

FCC Declaration of Conformity

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions:  (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception 
is suspected.

Radio and Television Interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct the interference 
by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops. 

m Move the computer to one side or the other of the television or radio. 

m Move the computer farther away from the television or radio. 

m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on circuits controlled by different circuit breakers or 
fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. 

Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the 
FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 

Responsible party (contact for FCC matters only):  Apple Computer, Inc., Product Compliance, 
1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.

Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits. 
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact 
during normal operation is minimized.

Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment regulations. 

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.
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VCCI Class B Statement

Europe — EU Declaration of Conformity

This device complies with the specifications ETS 300 328 and ETS 300 826, following the provisions of the EMC 
Directive 89/336/EEC.

Notify Your Telephone Company

Some telephone companies require that you notify the local business office when you hook up a modem to their 
lines.

Information You Need in the United States 

The internal modem complies with Part 68 of the FCC rules. On the back of this equipment is a label that 
contains, among other information, the FCC registration number and ringer equivalence number (REN). If 
requested, provide this information to your telephone company. 

m Ringer equivalence number (REN):  0.8 The REN is useful to determine the quantity of devices you may 
connect to your telephone lines and still have all those devices ring when your telephone number is called. In 
most, but not all areas, the sum of the RENs of all devices connected to one line should not exceed five (5.0). 
To be certain of the number of devices you may connect to your line, as determined by the REN, you should 
contact your local telephone company to determine the maximum REN for your calling area. 

m Telephone jack type:  USOC, RJ-11 An FCC-compliant telephone cord and modular plug are provided with this 
equipment. This equipment is designed to be connected to the telephone network or premises wiring using a 
compatible modular jack that complies with Part 68 rules. See the installation instructions for details.

Telephone Line Problems

If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect the modem to see 
if the problem goes away. If it doesn’t, report the problem either to your local telephone company or to your 
company’s telecommunications people. 

If disconnecting the modem eliminates the problem, the modem itself may need service. See the service and 
support information that came with your Apple product for instructions on how to contact Apple or an Apple-
authorized service provider for assistance. 

If you do not disconnect your modem when it is adversely affecting the telephone line, the telephone company 
has the right to disconnect your service temporarily until you correct the problem. The telephone company will 
notify you as soon as possible. Also, you will be informed of your right to file a complaint with the FCC. 

The telephone company may make changes in its facilities, equipment, operations, or procedures that could 
affect the operation of your equipment. If this happens, the telephone company will provide advance notice in 
order for you to make the necessary modifications to maintain uninterrupted service.  

The optional internal modem will not work with party lines, cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange (PBX). 

Telephone Consumer Protection Act 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains in a 
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it 
was sent and an identification of the business or other entity, or individual sending the message and the 
telephone number of the sending machine of such business, entity, or individual.
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Information You Need in Canada 

The Industry Canada (IC) label identifies certified equipment. This certification means that the equipment meets 
certain telecommunications network protective, operational, and safety requirements. The Department does not 
guarantee the equipment will operate to a user’s satisfaction. 

Before installing this equipment, make sure that you are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an acceptable method of connection to install the equipment. In 
some cases, you may extend the company’s internal wiring for single-line individual service by means of a certified 
telephone extension cord. Be aware, however, that compliance with these conditions may not prevent 
degradation of service in some situations. 

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated by the 
supplier. Any equipment malfunctions or repairs or alterations that you make to this equipment may cause the 
telecommunications company to request that you disconnect the equipment. 

In Canada, contact Apple at:  7495 Birchmount Road, Markham, Ontario, L3R 5G2, 800-263-3394

Users should ensure for their own protection that the electrical ground connections of the power utility, 
telephone lines, and internal metallic water pipe system, if present, are connected together. This precaution may 
be particularly important in rural areas.

m Load number:   0.3 The load number (LN) assigned to each terminal device denotes the percentage of the 
total load to be connected to the telephone loop that is used by the device, to prevent overloading. The 
termination of a loop may consist of any combination of devices, subject only to the requirement that the sum 
of the load numbers of all devices does not exceed 100.

m Telephone jack type:  CA-11

Informations Destinés aux Utilisateurs Canadiens

L’étiquette d’Industrie Canada identifie un matériel homologué. Cette étiquette certifie que le matériel est 
conforme à certaines normes de protection, d’exploitation et de sécurité des réseaux de télécommunications. Le 
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder au réseau de l’entreprise 
locale de télécommunication. Le matériel doit également être installé en suivant une méthode acceptée de 
raccordement. Dans certains cas, le cablage appartenant à l’entreprise utilisé pour un service individuel à ligne 
unique peut être prolongé au moyen d’un dispositif homologué de raccordement (cordon prolongateur 
téléphonique).

L’abonné ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus n’empechent 
pas la dégradation du service dans certaines situations. De fait, les entreprises de télécommunication ne 
permettent pas que l’on raccorde un matériel aux prises d’abonné, sauf dans les cas précis prévus par les tarifs 
particuliers de ces entreprises.

Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien autorisé 
désigné par le fournisseur. La compagnie de télécommuncations peut demander à l’utilisateur de débrancher un 
appareil suite à des réparations ou des modifications effectuées par l’utilisateur ou à cause de mauvais 
fonctionnement.

Veuillez contacter le fournisseur suivant pour des informations supplémentaires :  

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Apple Canada Customer Assistance Line:  800-263-3394

Warning  Users should not attempt to make such connections themselves, but should contact the appropriate 
electric inspection authority or electrician.
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Pour sa propre protection, I’utilisateur doit s’assurer que tous les fils de mise à la terre du secteur, des lignes 
téléphoniques et les canalisations d’eau métalliques, s’il y en a, soient raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions rurales.

m Numéro de charge : 0.3  L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute 
surcharge, le pourcentage de la charge totale qui sera raccordée à un circuit téléphonique bouclé utilisé par ce 
dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de l’ensemble des dispositifs ne dépasse pas 100.

m Type de prise téléphonique : CA-11

Information You Need in the United Kingdom

This terminal equipment is intended for direct connection to the analogue Public Switched Telecommunications 
Network and is approved for use within the United Kingdom with the following features:

m Modem facility

m Autocalling facility

m Autoanswer facility

m DTMF signaling

m Operation in the absence of proceed indication or upon detection of proceed indication

This product is in conformity with relevant regulatory standards following the provisions of European Council 
Directives 73/23/EEC (Low Voltage Directive) and 89/336/EEC amended by 92/31/EEC (EMC Directive).

Information You Need in Germany

Diese Modem-Karte ist als Endeinrichtung vorgesehen und muss an ein TAE mit F-Kodierung angeschlossen 
werden.

Diese Endeinrichtung ist in Konformität gemäss Niederspannungsrichtlinie 73 / 23 / EWG sowie EMC-Richtlinien 
89 / 336 / EWG und 92 / 31 / EWG.

Information You Need in France

Ce matériel est conforme aux normes applicables de sécurité éléctrique d’après la directive 73 / 23 / CEE et aux 
normes applicables de comptabilité éléctromagnétique d’après la directive 89 / 336 / CEE, modifié par la directive 
92 / 31 / CEE.

Information You Need in Australia

All telecommunications devices are required to be labelled as complying to the Australian telecommunications 
standards, ensuring the health and safety of the operator and the integrity of the Australian telecommunications 
network. To provide compliance with the Australian Communications Authority’s technical standards, please 
ensure that the following AT commands are maintained:

m ATB0 (ITU/CCITT operation)

m AT&G0 (no guard tone)

m AT&P1 (33/66 pulse dial make/break ratio)

m ATS0 = 0 or ATS0 = 2 (no answer or answer greater than one ring)

m ATS6 = n (blind dial delay acceptable range of 2–5 seconds)

m ATS11 = 95 (DTMF period between 70–255 ms)

Avertissement  L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit avoir recours à un 
service d’inspection des installations électriques ou à un électricien, selon le cas.
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For calls that are automatically generated, a total of three call attempts are allowed to a telephone number, with a 
minimum period between calls of 2 seconds. If the call does not connect after three attempts, 30 minutes must 
expire before automatic redialing may be initiated. Failure to set the modem (and any associated communications 
software) to the above settings may result in the modem being non-compliant with Australian 
telecommunications standards. Under these circumstances a user could be subject to significant penalties under 
the Telecommunications Act 1997.

Information You Need in New Zealand

This modem is fully approved to operate on the New Zealand telecommunications network under Telepermit 
number PTC 211/99/077. All telecommunications devices are required to hold a Telepermit and be labelled 
accordingly with the approved Telepermit number to comply with the New Zealand telecommunications 
standards, ensuring the health and safety of the operator and the integrity of the New Zealand 
telecommunications network.

To ensure compliance, all calls that are automatically generated should not make more than 10 call attempts to 
the same number within any 30 minute period with a minimum period between calls of 30 seconds. Failure to 
adhere to these standards may result in the modem being non-compliant with New Zealand Telecom standards. 
Under these circumstances a user could be subject to significant penalties.

Important  The grant of a Telepermit for any item of terminal equipment indicates that only Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It indicates no 
endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no 
assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a 
different make or model, nor does it imply that any product is compatible with all of Telecom’s network services.

Warning  This card must be properly secured in order for you to use it. Telecommunications network voltages 
exist inside the computer and the telecommunications line connection must be removed before opening the 
computer.
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